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The May 22nd, 2004
General Meeting will Feature:

Author & Consumer Advocate
Carey Holzman

Will Tell us about his new Book &
Answer All or Most of our Questions
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The Dynamic User Group Zealot

Will Give us a Look at:
Jasc Paint Shop Photo Album 4
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OCIPUG Web Page:  www.ocipug.org OCIPUG Information line: 714-535-0608

Special Interest Group (SIG) meetings
are held monthly as follows:
 1st Tuesday        7:00 PM - Internet
 2nd Tuesday       7:00 PM - Hardware
 3rd Tuesday        7:00 PM - Windows
 4th Tuesday        7:00 PM - Digital Photo

General Meetings are held  from
9:00AM to Noon on:
22 May                         2004
26 June                        2004
31 July                         2004
28 August                    2004
25 September              2004
For details see inside pages of
this issue, Web Page, or
Information Line 714-535-0608

Meetings of the Executive Board will
be held at 12:00PM on:
22 May                        2004
26 June                        2004
31 July                         2004
28 August                    2004
25 September              2004
All OCIPUG members are welcome

    May 22nd
General Meeting

Carey Holzman has been working on PCs professionally
for more than 14 years, and as hobby (with a TRS-80
Model I and, later, Atari 400) for more than 20 years. Born
in Detroit, Michigan, he currently lives in and has been a
resident of Glendale, Arizona since 1980.
He hosts his own weekly Internet-based computer talk
show “Computer News And Views” which airs over C-
Band Satellite radio as well (www.danapretzer.com). Carey
considers himself to be a consumer advocate, warning
people of industry cover ups, such as the recent leaking
capacitor issues that have plagued most motherboard
manufacturers in recent years, as well as warning of
software scams, e-mail hoaxes and other related ‘rip-offs’.

His new book, The Healthy PC, was released in early
November of 2003 and has sold out of it’s first printing in
the first 14 weeks. The book empowers users to take back
control of their PCs from unscrupulous marketing
companies and other Internet ‘bad guys’ using plain
English and recipe-like steps that explicitly show the user
exactly what to click and why each step of the way. At
230 pages, the book covers each topic with three
different recipes: One for Windows 98, one for Windows
Millennium and one for Windows XP. These are the three
main consumer-based operating systems in use today
and will be until Microsoft releases its successor to
Windows XP, not due until 2006.

Carey’s presentations are not what you might be used to.
Carey likes to get the audience involved and, rather than
read from a scripted Power Point presentation with the
lights off, instead, he prefers to customize each
presentation based on the interest of the group he is
speaking with. As a result, you never know quite what to
expect and two presentations are never the same.

The Healthy PC
With Carey Holzman

Jasc Photo Album 4
With

Cheryl Wester

 Get your photos out of your camera and into your life with Jasc
Paint Shop Photo Album. Now you can quickly and easily make the
most of your digital photos. Get your photos from camera to com-
puter in just two clicks. Then enhance, organize, and share those
digital memories in a flash with Photo Album's fast and easy-to-use
tools. It's all right here. Dash off a quick e-mail filled with your
photos or create a fabulous Video CD slide show with music. Click
once for Quick Fix color corrections or create a keepsake in sepia
with a classy photo edge. Do a quick search of your collection or
develop your own personalized keyword checklist system.

Here is a little info about Cheryl:
As a high school computer teacher I'm constantly helping my peers
as well as my students. They know that if they need help I'm there for
them. I do the same for my User Group and other User Groups as
well. As a Pocket PC fanatic, I've also presented on the PPC to
several groups and had the privilege of presenting at a regional
meeting in San Diego this last August. PowerPoint and Outlook are
my next scheduled presentations. I'm always eager and willing to
help others learn more about computers.

Enthusiasm for computers has brought me a lot of fun and opportu-
nities to grow and learn. I've even converted several people in my
group from Palms to a PPC and the Windows CE operating system!
Helping members of my group helps me grow as an individual. It
feels good to see others learn and benefit from the little bit of
knowledge I do have. Nothing feels better than seeing someone's
eyes light up as they understand a new concept or find a long last
relative on the Internet. Realizing that we are never to old to learn
something new is an awesome feeling that I love to share.
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SPECIAL INTEREST GROUP
(SIG)

June 1st 2004
          Internet / Web Publishing 1st Tuesday     7:00PM

  Mark Borison    webmaster@ocipug.org
       Michael Moore   president.bod@ocipug.org

(All Special Interest Group (SIG) meetings  are held at
the Costa Mesa Senior Center on the southeast corner
of 19th and Pomona at the times noted below.)
The next SIG metting will be:

SCHEDULES AND REPORTS OF EVENTS

                         June 22nd 2004
Digital Cameras / Scanning  4th Tuesday  7:00PM

    David Wintle    allart@pac.bell.net

                          June 8th 2004
         Hardware - 2nd Tuesday. 7:00 PM
     Ed Leckliter     eleckliter@adelphia.net

SIG MEETINGS

President Michael Moore 714-535-0608 president.bod@ocipug.org
Vice President Dave Wintle 949-548-7994 allart@pacbell.net
Secretary Frank Mastroly 714-960-9472 secretary@ocipug.org
CFO/Treasurer Leonard Stein 949-454-0158 leonardstn@netscape.net

    Director-2003 Red Davidson 949-548-0413 red.d@juno.com
Director-2003 Ed Leckliter 310-944-6453 eleckliter@adelphia.net
Director-2003-2004 Morris Fier 949-646-8292 d_fier@sbcglobal.net

    Director-2002 Sandi Tierney 714-648-2218 gadgetgoddess@juno.com
Past President Leonard Stein 949-454-0158 leonardstn@netscape.net
Long Range Planning Leonard Stein 949-454-0158 leonardstn@netscape.net

   README.DOC Editor Mark Borison 714-963-8296 mborison@yahoo.com
   Webmaster Mark Borison 714-963-8296 mborison@yahoo.com

Programs Mark Borison 714-963-8296 mborison@yahoo.com
SIG Coordinator Robert Strader 949-646-1475 rstrader@attbi.com

Support Our Sigs

 June 15th 2004
                   Windows - 3rd Tuesday. 7:00 PM
                   Bob Strader     rstrader@attbi.com

Join Class Action Against
Dell Computer

A Class Action is forming against Dell Computer for its
warranty practices and tech support.  If you purchased
your Dell computer or notebook in 2001 and 2002, we
would be interested in talking to you.
Please call attorney
Randy Rothschild at 310/207-8530.

Randy Rothschild
randy.rothschild@verizon.net

Westminster Senior Center
Needs an Instructor

The Westminster Senior Center needs a volunteer to
teach a basic computing class. Anyone interested in
devoting a couple of hours on Monday mornings to
help bridge the digital divide should contact me at
webmaster@ocipug.org or mborison@yahoo.com
The computer center there is equipped with almost
new computers and a very nice projection system.
The center is located near the insection of
Beach and Westminster.

Public Service Announcements
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Recap of May 4th
Internet Special Interest Group (SIG)

Michael R. Moore

The May 4 Internet SIG started at 7:10 pm, and was attended
by nine members, one guest Including (Webmaster, SIG
Leader,and primary) presenter Mark Borison.
The focus of this SIG is the internet, and how it relates to
personal computers, Mark also gave out a couple of handouts
showing such things as keyboard shortcuts  in windows.  How
to create bookmarks/favorites, and an easy, and inexpensive
way to move your favorites to another computer using web
based e-mail, And  how to change your internet browsers
homepage.

During the course of the evening, the following web sites were
introduced and discussed to those in  attendance.
♦ http://www.vlaurie.com/  - contains a collection of com

puter education resources with emphasis on the Windows
operating system and on safely using the Internet

·
♦ http://www.kbb.com/ - find out how much your car is really

worth, with the help of Kelly Blue Book

♦ http://www.belarc.com/–
Creators of Belarc Advisor builds a detailed profile of your
installed software and hardware and displays the results in
your Web browser. All of your PC profile information is
kept private on your PC and is not sent to any web server.

♦ http://www.aida32.hu/ - touted as AIDA32 is the ultimate
system information utility

♦ http://www.pcdon.com/
homepage of Don Edrington, Local PC GURU, who has
created a one-stop shop clearing house for a vast amount
of Microsoft Windows (and Related) Information

♦ https://gmail.google.com/  - update on google’s
upcoming e-mail service

♦ http://www.microsoft.com/security/protect/ - Information
from Microsoft, including steps you can take to improve
your computer’s security.

The meeting was then closed at 9:00 pm.  The next Internet
SIG will be on Tuesday June 1, 2004 and will start at 7:00 pm
in the upstairs meeting room. Hope to see you there. . .

Internet SIG

Sites discussed at the April 2004
Windows Special Interest Group (SIG)

Reported By:
Michael R Moore

The April 20, 2004 Window SIG started at 7:10pm, and was
attended by 11 members and two guests, Including (SIG
Leader,and primary) presenter Robert Strader.

The evening's discussion started with tips & advice relating to
the installation of and the general use of smart media drives with
Windows XP. On a new computer, what software/hardware
should you consider purchasing with your computer?

1) Anti Virus Software (such as Macafee Antivirus, or Norton
AntiVius)

2) Firewall {ether Hardware (such as a Router)   or software
(such as Zone Alarm from zonelabs.com)

BlackViper.com details what Items are are/not needed when
your computer boots. Using the  (new and improved) Microsoft
Help files to assist during systems diagnostics. Removing
Spyware and adware programs on your computer
Using Spy Bot Search & Destroy (http://security.kolla.de/  or
http://www.safer-networking.org/ ) ,
Zone Alarm (http://www.zonelabs.com/) ,
Adaware (www.lavasoftusa.com/)
Union Asia Network Technology (http://
www.uant.netindex.html) advocates of Internet Privacy and
Security includes information and resources on removing
adware and spyware from your computer
Gibson Research Corporation, (http://www.grc.com/)
homepage of former OCIPUG Member Steve Gibson, manufac-
turer of Shields up (internet based utility for checking your
fireware, also includes information and solutions on keeping
your computer safe while online.
Belarc (http://www.belarc.com/)  maker of Belarc Advisor.
This program, builds a detailed profile of your installed software
and hardware, including Microsoft Hotfixes, and displays the
results in your Web browser.
Alda 32 (http://www.aida32.hu/) A Hungarian company, which
makes a program similar to Belarc useful in benchmarking your
computer

The next Internet SIG will be on Tuesday May 18. 2004, and
will start at 7:00 pm in the upstairs meeting room.

Hope to see you there. . .

Windows
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OCIPUG Hardware SIG -
Meeting Recap

Meeting Date: May 11, 2004
There were 10 attendees (including SIG Leader, Ed Leckliter) —
some flimsy excuse about a Laker’s game.

Featured Topic(s): Your New System (2003 Update):
Installing Your OS and Device Drivers; Functional Testing

Hardware Submissions - Eugenia Frerichs brought in her semi-
finished “new system” on which she had already installed XP/
Pro.  She had been experiencing an error message when booting
and Ed traced it to the floppy power cable being unplugged
(probably occurred during the process of tying down the power
and data cables).  Once reconnected, the error went away.  The
OS appears correctly installed.  Ed went back into the system
BIOS and changed the boot drive to IDE-0 (Euginia’s hard
drive) - it had still been looking for a boot CD from the OS
installation. 

Random Access - several questions were responded to during
the OS installation process (none recorded or recalled).  None
remained by the time we reached the “formal” random access
segment.

Next Meeting: June 8, 2004

Next Meeting Featured Topic(s):
Upgrading the OCIPUG General Meeting Room Computer
(pending Board approval of Ed’s contribution of the
motherboard, CPU, and RAM from the just completed series).

Following Meeting: July 13, 2004

Following Meeting Featured Topic(s): TBD

File(s) attached - also posted on the OCIPUG Hardware SIG
web site (http://www.edscustomcomputers.com/
welcome_to_the_ocipug_hardware_sl.htm)

Presentation slides in Microsoft PowerPoint format (.ppt).

For the latest OCIPUG Hardware SIG info, please check
the SIG’s web site or contact Ed Leckliter (SIG Leader)
at eleckliter@adelphia.net.

General Meeting Notes
Reported By:
Michael Moore
(Filling in temporarily for Frank Mastroly)

The  April 24, 2004 General Meeting was called to order at
9:05am by (yours truly) President Michael Moore.

This months meeting was attended by 22 Members, and 1 guest
(Members attending included Karl Cook (Member# 1742)) who
has come back to us after an 8 year absence.  Welcome Back
Karl! ! !. (Hopefully this is a sign of things to come, with
former members coming back again to OCIPUG) and we will
see him again before April, 2012.

Our very own Mark Borison gave us two excellent presenta-
tions. The first was on what e-Bay is, and how to use it., Mark
showed us how the world's biggest auction works, how to buy
things,  and how to sell things. He also highlighted some of the
hidden features on e-bay (including the online multimedia
tutorials). The website for e-bay is http://www.ebay.com . The
audio tour can be accessed by going online to: (http://
pages.ebay.com/education/)

Mark also highlighted information from the book e-Bay Hacks
(Author: Karp David A ISBN: 0-596-00564-4 List Price:
$ 24.95) information on this book can be found online at http://
www.oreilly.com/catalog/ebayhks/ Also, another part of Mark's
presentation focused on a e-bay oriented website from a North
Carolina Based Antiques Dealer, Drexel Antiques, who have
created their own Tutorial on how to use e-bay.  This can be
found on the internet at  http://www.drexelantiques.com/
ebayhelp.html
The second presentation showed our new and ever improving
internet website  http://www.ocipug.org/, including links to
various internet Reference Sites, Tutorials, and even some of
our own OCIPUG members personal websites
After Mark's Presentation on the OCIPUG web site. We held
our Monthly raffle, the results of which were:
Name Prize(s) won
Robert Walker Flip Album 4.0, SureThing CD Labeler
Ed Fitch E-Bay hacks (book)
Mark Borison Play Poker (Software)
Warren Frandsen P. Cuzanne CD (Software)
Eujenia Fredrichs 50 Great Utilities CD (Software)
Warren Frandse Office 97 (Book)
William Paradee Windows 98 for Dummies (Book),

Tamagotchi (CD)
Herb Huey Airline Manager (CD)
After the conclusion of our drawing, the meeting was adjourned
at 12:10 pm.
Our next meeting will be Saturday May 22nd, check our
website (http://www.ocipug.org/) for current information as to
our programs, and general club information.
(Please Note: This is a week earlier than we normally meet,
because of the Memorial Day Holiday the following week.)
Invite a friend look forward to seeing everyone there for 2
excellent presentations.
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PRESIDENTS REPORT

By:
Michael Moore

Hello again.We are quickly approaching the summer season,
which means a couple of things to OCIPUG.

1) The summer vacation season, which is where the attendance
of our general meeting and our SIG meetings tends to fluxuate,
which means that it is even more important for you to attend.

2) Our Annual elections where you will decide who will lead
your organization into the future, and what path the club will
take to preserve its longevity.While it has been my pleasure to
preside over the organization over the past 10 months it is my
hope that more members will decide to take a more active role
in their club. Although please remember, that you don't have to
be a member of the board of directors to make a difference in
your club. The simple act of your attendance at both the SIG
meetings, and the general meetings, and your continued
assistance in both the setup and the subsequent tear down
afterwards speak volumes.

3) The Southwest Regional Users Group Conference in San
Diego, will be held 8/6 - 8/8. OCIPUG's attendance has been
slowly increasing over the years, to the point where OCIPUG
has one of the larger delegations at the event.  I hope that this is
a trend that will continue and if you have not attended this
event in the past, it is a great event, where you will spend 2 1/2
days talking about computers, feasting and enjoying the
company  of User Group members from all over the Southwest
Region.

Even though the conference does not start until August 6, 2004,
I've found, that the sooner that you register for the conference
and lodging, the more money you can save. Follow the link
from our homepage for all of the details on the conference.

Even though everyone was not at the April General Meeting,
we still did manage a respectable turnout, as I noted in the
meeting minutes of the secretary's report. I feel that if we can
continue to do this, it will make the job of our program director
that much easier when it comes to approaching computer
vendors and requesting products and presentations  from them.

Also I hope that you have had the opportunity to check our
OCIPUG's ever evolving internet website. As I know how hard,
our webmaster Mark Borison has worked to make it more than
just your ordinary website, Mark has succeeded in making our
website into more of a web portal, and I hope that you (like me)
are finding  the site to be more and more useful every time you
visit.  Our website is just one way that we can help keep you
informed between meetings.  OCIPUG also has implemented
new e-mail addresses for the officers.  If there is anything that
you ever need or have questions about, I hope that this will be
another way for us to exchange thoughts and ideas between
meetings.This month's General Meeting includes presentations
By the Author of The Healthy PC, Carey Holzman, as well as
OCIPUG's own Zealot, Cheryl Wester who will show us Jasc
Photo Album 4!
 I know that our Program Director Mark Borison appreciates
your attendance and participation  during our meetings which
was so clearly displayed during last month's meeting.
As you can tell, we have a lot of exciting things ahead of us,
which with your continued support and enthusiasm will
contribute to a successful entry into our 20th Anniversary..

Respectfully,
Michael Moore
OCIPUG President

Recap Of  April 2004 Scanning and Digital
Photography Special Interest Group (SIG)

Reported By:
Michael R Moore

The April 27, 2004 Internet SIG started at 7:15 pm, and was
attended by 13 members And 3 guests, Including SIG Leader,
(and primary) presenter Dave Wintle.

Dave Wintle gave an extremely informative presentation
on how digital cameras and lenses interact in the typical
digital camera to produce pictures.

The next Scanning and Digital Photography SIG will be on
Tuesday May 25, 2004, and will start at 7:00p in the upstairs
meeting room.

Digital Photography
and Scanning Sig
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Getting to Know Google
by Billy Mabray,
Oklahoma City PC Users Group

These days, whether you consciously choose it or not, your
Web search engine is probably Google (http://
www.google.com). That’s because most search sites, whether
they admit it or not, are powered by Google. And, why not?
Google rose to the top of the search engines because its formula
provided more relevant search results than any other. Also, its
deceptively simple page makes it fast and easy to use.

I say deceptively simple because, underneath that friendly,
colorful logo is a powerful search system that can accept
queries as complex as you want to make them. Many people
don’t realize that if they do not find what they want on the first
try, there are techniques they can use to improve their results.
There are also ways to search Google that are more appropriate
for certain specialty queries. And, Google is hiding a few extras
that take it beyond a search engine into an amazing reference
tool.

Let’s start with an example. We’re cooking dinner tonight, and
we need a recipe for spaghetti sauce that does not use sugar.
We might go to Google and type in this:

no sugar spaghetti sauce recipe

Google tells us we have about 56,000 results to wade through.
A daunting task, considering the first page doesn’t seem to
contain anything relevant. The first thing we will try is
grouping our search terms into phrases, using double-quotes.
This tells Google that certain words should be searched for
together. So, we try this:

“no sugar” “spaghetti sauce” recipe

That certainly narrowed things down, didn’t it? This is a good
technique to use when your search contains a lot of common
words that could appear together in different contexts than what
you are looking for. Unfortunately in this case, our first page of
results is still not as relevant as we would like. The next thing
we will try is searching for pages that do not contain a certain
term:

-sugar “spaghetti sauce” recipe

This tells Google that we want pages that are about “spaghetti
sauce” recipe, but specifically do not contain the term sugar.
That seems to have done it—our first page of results is chock
full of spaghetti sauce recipes that don’t use sugar.
“Subtracting” a term can also be useful when what you are

searching for has multiple meanings. For example, if you are
researching the “Holy Grail,” you might want to add “-Python” to
your search to eliminate all the references to the movie Monty
Python and the Holy Grail.

Now, maybe spaghetti sauce is too specific—we might want to
also consider marinara sauce. In that case, we use Google’s or
syntax:

-sugar “(spaghetti | marinara) sauce” recipe

When there are multiple words that will satisfy our search, we
can group them with parentheses and separate them with the
“pipe” character—a vertical line that is most likely on the right-
hand side of your keyboard. Google will then search for
references to “spaghetti sauce” or “marinara sauce.”

At this point, we’ve become so intrigued by what we can find
with Google, we’ve completely forgotten about dinner. Now we
are interested in just how many different chicken casserole
recipes we can find. Here’s one way:

“chicken * casserole” recipe

Notice the asterisk. This is called a wildcard. It tells Google that
we don’t care what word comes between chicken and casserole,
but there should be something there. This can be particularly
useful when you know most of a title of something, but are
unsure of all the words. This particular search brings back all
kinds of chicken casserole recipes. Something tells me we better
just eat out tonight.

Besides its standard Web search, Google has many specialty
searches that are triggered either by a keyword or simply by
what you are searching for. For example:

site:microsoft.com “Internet Explorer” patches

This searches for references to “Internet Explorer” patches on
microsoft.com only. If your favorite Web site does not offer a
search function, this is a pretty good substitute.

Maybe we want to know which sites on the Web link to the
OKC PC User’s Group Web site:

link:okcpcug.org

We can also tell Google that what we are looking for is in an
Adobe Acrobat PDF file:

filetype:pdf refrigerator manual

Google pays attention to what you are searching for, and offers
helpful services based on what it thinks you want. For example,
have you ever noticed Google shows your search words in the
blue bar above your results? The search terms that are
underlined link to a definition of that word at dictionary.com. If
you spell a word wrong,

Cont. Next Page
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Google Cont. From Previous Page

Google will prompt you with the correct spelling and ask if you
would like to search for that instead.

Google has many tricks like this up its sleeves. Search for a
phone number, and Google will do a reverse lookup on the
number. Search for a name with a city and state and/or zip code,
and Google will look up their phone number. Search for an
address and you will get links to maps of that location. Include
a zip code with your search terms, and Google will offer you
local  results—Web sites for locations near the zip code,
ordered by distance. You can even type in a shipment tracking
number, and Google will figure out who the shipping company
is and give you a link to the tracking information.

Google offers some services that have nothing to do with
searching. Try this:

68.12 + (68.12 * .2)

The Google calculator will return the result of this
computation. Fun, although, admittedly, not particularly useful.
The Google calculator can be useful though, for things like
conversions:

68mm = ? inches

You can do all kinds of conversions using Google—a handy
tool whenever you get around to making that spaghetti sauce.

Google is much more useful than most people realize—we’ve
only scratched the surface of what Google can do. If you are
interested in more, check out Hacking Google by Tara
Calishain and Rael Dornfest. It includes many more search
tips, and information for programmers who want to include
Google search results in their applications. As you explore
what Google can do, you will probably discover that Google
feels like more than just a Web site.

In fact, Google is your friend.

Billy Mabray and his wife, Angela, own Smart Goat, a
local software development and web design
business.  They are members of the OKCPCUG.
Comments or questions on the article are welcome
and can be addressed to:   billy@smartgoat.com.

There is no restriction against any non-profit group
using this article as long as it is kept in context with
proper credit given the author.  The Editorial
Committee of the Association of Personal Computer
User Groups (APCUG), an international organization
of which this group is a member, brings this article to
you.

Here's a Tip:
PC User Groups Are Great
By Steve Bass
From the June 2002 issue of PC World
Posted Wednesday, April 24, 2002

Imagine that you have a problem with your PC. (Not particularly
difficult, I know.) Now visualize describing your dilemma to an
auditorium packed with 300 bright, well-informed, and witty
computer professionals and enthusiasts. In no time flat, your
problem is solved. That's a computer user group, folks. These
amazing resources were the center of the PC user community in
the pre-Web era. They may be less prominent these days, but
they're still alive, kicking, and worthwhile. You'll find user
groups in most cities, and membership usually costs less than
$50 per year. To prove just how valuable these groups can be, I
rustled up a sampling of PC tips from group members.

Instant System Properties: You needn't go through a series of
cascading menus to open System Properties.

TIP If you have a Windows keyboard, simply hold down the
Windows key and simultaneously press Pause (at top-right of the
keyboard) to access information on your PC.
-Roger Griffin, The Users' Group Network,
Granada Hills, California

Jump the print queue: Sometimes you realize that you've just
sent several documents to your print queue, but the one you sent
last is the one you want printed first.

TIP Double-click the printer icon in your system tray and drag
the last document to the top of the list of files in the queue. It
will print immediately after the file currently being processed.
-Mean Drake, the Colony Computer User Group,
Murrieta, California

How old is that Web page? Have you ever wondered when the
Web page you're visiting was last updated? Here's a neat Internet
Explorer 6 trick for finding out.

TIP In IE 6's Address field, simply type javascript:alert
(document.lastModified) and press Enter to see the most recent
update's time and date in a pop-up window.
-Dennis Courtney, the Capitol PC Users Group,
Washington, D.C.

Old modems for new broadband: If you've switched to a
cable-modem, DSL, or other broadband service, your old dial-up
modem still has a good use.

TIP Leave your modem connected to the phone line and attached
to the phone. When you want to call a phone number you see on
a Web site or in your contact manager, have your modem dial the
number with only a few mouse clicks. Windows' Phone Dialer
applet makes this possible.

Cont. on P. 10
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Book Review

The Healthy PC
by Carey Holzman

Book review written by Bob Click
Greater Orlando Computer Users Group.

This 230-page book will assist you in the preventive mainte-
nance and tweaking of your home PC. It is intended for novices
and seems to fill the bill pretty well. It covers Windows 98/ME/
XP. The first thing I noticed is that he wants the reader to be on
the same page, so to speak. He begins by having you easily
alter certain settings on your computer (telling you step by
step) so that any time he is giving instructions you will see the
same screen that he is describing and the same examples that
are shown in the book so there is no confusion. Good plan.

Next he describes cleaning up your hard drive. That means
deleting temp files and some other unnecessary trash. He did it
much different than I would have and I think I learned a better
way, but would later read how to do it my usual way. Then he
went into Scandisk and defragging along with an explanation
for why to do it. Not only that but he has you bring up the
Scandisk Report and helps you read it by pointing out the
important information you may not even know you are looking
for. Nice touch.

He quickly gets into your computer's performance issues and
right to one of the greatest problems, spyware, along with a
good explanation of it. All the warnings are there along with
the "Read the EULA (End User Licensing Agreement)"
warning when installing new software, as well as a warning
about the messages you get enticing you to download some
"great" software to prevent your computer from "sending out
your personal information." He talks about the most popular
spyware removers, then goes into antivirus products, even
telling you how to acquire a free antivirus tool. So far I like this
book for its thoroughness and its simplicity.

He spends some time on software bugs and updates (or
patches), and the reasons for each. In that regard, he confines
that discussion to Microsoft products.

From there Carey plunges into a great explanation of modems
and their different specifications. He guides you through steps
to possibly increase your modem speed and covers a lot of
territory. Through it all, I never got lost once and understood it
all. My brain can be pretty bad at times, but I did well here. He
covers both dialup and broadband connections, even giving
you places to go on the Internet to check your modem perfor-
mance for either kind.

Chapter 4 covers Internet items. There is a great section on
cookies (people often misunderstood them) with good explana-
tions. Temporary Internet files are well covered as well as pop-

ups and how to cope with them. I thought that chapter was
pretty thorough with its 26 pages.

He then talks about E-mail, spam and hoaxes. It even covers
help for AOL users and filtering for some popular email
sources such as Hotmail, NetZero and Yahoo. That chapter
covers quite a bit about filters.

The firewall chapter gives a pretty good explanation of the
concept as well as covering both software and hardware
firewalls. 14 pages go into detail and cover Universal PnP as
well as PnP and explaining the difference. I was unaware of the
difference between the two. It gives step-by-step instructions to
turn UPnP off in Windows ME and XP.

The next chapter contained "basic computer tips" and this is
where I really started to pay attention. He explains DMA
(Dynamic Memory Access) and goes into settings for it,
advising you to make settings that are against the Windows
warnings. That was interesting. He talks about downloading
and using Tweak UI (an unsupported but helpful download
from Microsoft) offering some guidelines to keep you out of
trouble. A nice explanation of font limitations (how many are
installed) follows and ways to control them. There is informa-
tion describing swap files and steps for making adjustments.

Next he gets into computer resources and has a brief explana-
tion. He also delves deeply into startup and the problems that
too many items in the startup folder can cause. Along the way
URLs are offered for a more complete explanation of each item
discussed. He gives tables showing the suggested settings for
many items you might see in your "msconfig" startup tab. Also
covered is the use of the Add/Remove tool with a brief warning
about items that could become installed on your computer via
the Internet without your knowledge. He shows how to turn off
"error reporting to Microsoft" and how to disable Windows
XP's automatic restarting of your computer when it encounters
a serious error. Also discussed in that chapter is when and why
to convert your file system from FAT32 to NTFS, which he
considers a more robust system.

Next he offers several items starting with a discussion about
power management and related items. It goes into a short
explanation of USB, and even discusses "flash drives" along
with a short instruction about backing up your data.

Chapter 10 is about upgrading and compares old technology
with new. It covers most components and peripherals, but does
not go into detail about doing it. Remember that this book is for
the novice and not meant for a more advanced person with
additional experience.

Following that he touches on preventive maintenance such as
blowing out dirt and debris from inside your computer with
suggestions on the different ways your case might come apart.
It's interesting that he pointed out looking for the possibility of
leaking capacitors that might be on motherboards made during
certain years. It has a nice section about updating drivers and
how to check if a new one is needed, plus how to find it. He
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Healthy PC Review Cont.

suggests places on the Web to get help with updating drivers if
Chapter 12 talks about light trouble-shooting of your computer.
It explains some special troubleshooting features included in the
different versions of Windows and how to use them if some-
thing goes wrong. Since this book deals mostly in improving the
performance of your PC, it is not written for any technical
trouble-shooting that might get the novice PC user into trouble.
Carey warns about downloading certain types of software from
the Internet that is said to improve your PC's performance, and
explains the possible consequences. A number of instructions
are included in that chapter for the later versions of Windows.

In the appendix, he supplies places on the Web to get free
technical support and offers you the URLs. He even recom-
mends user groups as a place to go for help (I agree wholeheart-
edly) and I'm not surprised since he is a member of Phoenix PC
User Group <www.phoenixpcug.org> and plans to retain that
status indefinately. I know it is not that simple unless you
already belong to a user group and are known, but it certainly
has great possibilities if you are sincere when you attend a
meeting. I have seen many people who only come to a meeting
trying to get free help, but do not intend to join the group.

I was disappointed to see that Carey merely explains what a
network is, but does not say anything about setting one up, but
then again, this book is intended for the novice and networks
are a bit complicated, in my opinion. I still don't understand
how to set one up after all these years. However, he does give
you some URLs for where to get information, in that regard,
including his own URL.

I was also disappointed when I came to his reference to explain-
ing the difference between resources and memory. He mostly
recommended some URLs for that purpose, but I do agree that it
is a complicated and lengthy subject.

There were about four pages of the most popular questions and
answers for problems in Windows 98/ME and two pages of the
same for Windows XP. In my opinion, that would only scratch
the surface, but where do you stop with the possible questions?
There are also a few suggestions for a few very useful "free"
programs that you can download. The book is easy to read and
not that long. If he had included some of the items in it that I
would have liked in addition, the book would probably be
lengthy and might even get the reader into trouble, so he
probably did it right.

The publisher is McGrawHill/Osborne and, again, the author is
Carey Holzman. The retail price is $16.99, which seems
reasonable for this 230-page book with lots of information for
the novice. It is doubtful this book would get you into any
trouble and will, more than likely, help you learn some simple
steps to keep your PC running faster and more reliably than ever
before.

    PC User Groups Are Great Cont. From P. 8

To open Phone Dialer in Windows 9 x, Me, and 2000, click Start,
Programs, Accessories, Communications, Phone Dialer. If it's not
there, open Control Panel, double-click Add/Remove Programs,
and choose the Windows Setup tab (Add/Remove Windows
Components in Windows 2000). Select Communications, click

Details, and check Phone Dialer (you may need your Windows
CD-ROM to install it). To place a shortcut to Phone Dialer on
Internet Explorer's Links toolbar, first open IE. (If the Links
toolbar isn't visible, click View, Toolbars and check Links.)
Then select Start, Programs, Accessories, Communications,
hold down Ctrl, and drag the Phone Dialer icon to the Links
toolbar. Now when you want to dial a phone number listed on a
Web site, copy the number, select the Phone Dialer shortcut on
the Links toolbar, paste the number into Phone Dialer's "Num-
ber to dial" field, and then click Dial. Pick up your phone and
click Hang up once the dialing is complete. No more misdials
from clumsy fingers or faulty memory.
-Steve Shank, the Golden Gate Computer Society,
San Rafael, California

TIP It's good to be grouped: Two great resources for finding a
user group in your vicinity are the Association of Personal
Computer User Groups and Ash Nallawalla's list. And no, not
all group members are pocket-protected propeller heads. Some
members are IT executives and consultants, but many are
ordinary folks who just want to get the most out of their PCs.
Nearly all groups produce a newsletter, often with member
listings (some with phone numbers) in case you need help.
Groups frequently hold smaller meetings-called Special Interest
Groups-that focus on specific topics. For example, the Pasadena
IBM Users Group had Windows, Networking, Visual Basic, and
Macromedia SIGs. By the way, that's the group I was president
of, but don't let it keep you from joining.

Contributing Editor Steve Bass can be contacted
at homeoffice@pcworld.com. He also pens a
free, weekly Home Office newsletter. Here's the
link to subscribe to his rantings: http://
www.pcworld.com/resource/newsletters/
index.asp?sub_source=PCWXH4
Reprinted with permission from the
June 2002 issue of PC World.

There is no restriction against any non-profit group using
this article as long as it is kept in context with proper credit
given the author.  The Editorial Committee of the Associa-
tion of Personal Computer User Groups (APCUG), an
international organization of which this group is a member,
brings this article to you.
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Email Etiquette
In order to efficiently communicate on the Internet it is critical
to understand the unwritten rules of email communication.
Please use these tips as a guideline to online email
communication.

1.) Unless you are using encryption, Internet E-mail is not
secure.

2.) Do not use all capitals in email exchanges, it is considered
SHOUTING and is considered rude.

3.) Keep in mind that the Internet is international, words and
humor can be perceived differently by different cultures.

4.) When replying to messages be aware of “cc:” field.
Recipients listed in the “cc:” field will receive a copy of the
post. (The “bcc:” field sends messages blind, meaning
recipients don’t know that someone else has received a copy of
the email or been carbon copied)

5.) Use emoticons :-) or <g> to indicate expression.

6.) When forwarding email be sure not to create a loop in the
system. In addition, be sure not to setup auto-responders to
reply to every email, or endless loops will be created.

7.) There can be costs associated with Internet connectivity
and downloading emails. Do not send attachments that take a
long time to download, without the recipients consent.

8.) Include in the “subject” line a heading that relates to the
message body.

9.) Use 4-6 lines for your signature line, this is an opportunity
to highlight your business or company information, but don’t
be ostentatious..

Mailing Lists & Newsgroup Etiquette

In order to participate in news groups, you must have an
understanding of newsgroup etiquette.

1.) Be familiar with lists/newsgroups prior to posting, read
posting.

2.) Keep in mind that newsgroups and mailing lists are
frequently archived and that posts will be preserved.

3.) If you are replying to a message be sure to include the text
of the original message which you are replying to. Use “>”
indicators if your mail program does not do this for you.

4.) Don’t get involved in flame wars (or material which is
personal and unproductive).

5.) Keep in mind that the Internet is international, words and
humor can be perceived differently by different cultures.

6.) Use 4-6 lines for your signature line, this is an opportunity to
highlight your business or company information, but don’t be
ostentatious..

7.) When responding to a post, keep the subject line the same,
so that it will appear in the same thread.

8.) Cross posting to multiple lists is often prohibited. Read
posting guidelines.

9.) Expect delays in moderated forums, each posting must be
approved.

10.) Anonymous posts are unaccepted in many newsgroups.

11.) Be aware that some people use aliases when posting to
Usenet groups to avoid SPAM (unsolicited email). Also keep in
mind that anything goes on unmoderated Usenet.

12.) Most lists don’t allow for binary attachments.

Resources -

Library of Emoticons -
http://www.instant-messaging-software.com/
instant-messaging-emoticons.htm

Library of Email Acronyms -
http://www.email-software.org/email-
acronyms.htm

Email Client Software -
http://www.messaging-software.net/e-mail-client-
software.htm

About the Author -Sharon Housley manages
marketing for NotePage, Inc. http://
www.notepage.net a company specializing in
alphanumeric paging, SMS and wireless
messaging software solutions. Other sites by
Sharon can be found at http://
www.softwaremarketingresource.com , and http:/
/www.small-business-software.net
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A Look Back
at OCIPUG's Past

The Newsletter
Before it was named README.DOC

I recently found the 1st 4 issues of OCIPUG's newsletter while looking through some papers, I received from
Director Red Davidson. The Newsletter at this point was fairly crude but it did express some of the tenets that
OCIPUG adheres to even today.

In the editorial Tom Sutro the editor says the one of the 1st needs is a name for the newsletter and when
suggestions are submitted the membership will vote on 5 that the advisory committee feel are the best. Also in
the newsletter is a software Library report by Bonnie Ulanovsky, the software librarian that at the time there were
200+ programs available.

In Tom Sutro's Membership report it was stated that currently there were approximatelt 45 people who had
attended at least one meeting and 17 had already paid their dues. The rest of the newsletter is made up of
minutes from previous meetings (General & BOD) that I will be posting to the website so I will not go into here.
The newsletter was made up of the Front Cover & 3 typewritten mimeographed pages. I will post the front cover
and a short reprise of OCIPUG's 2nd newsletter next month.

Mark Borison
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Secure Passwords
Keeping Your Passwords Secure

As the web has evolved, so have the methods of collecting
personal information. A large number of websites require
visitors to register to gain access or participate. While the need
for registration is understandable, tracking user names and
passwords can be burdensome. Consider using software to store
your passwords, in a safe accessible manner.

Most websites have privacy policies, but the value of privacy
statements are only as honorable as the people behind the
websites. Here are suggestions for keeping passwords and your
information secure:

1.) change your password frequently

2.) never share your password with anyone

3.) try to choose a password so it doesn’t need to be written
down, but not so obvious others would easily guess the
password

4.) be sure your password is at least 6 characters

5.) don’t use a password containing all the same characters

6.) don’t send your password via email or provide it over the
phone

7.) don’t use pet, family or friend names

8.) don’t use your telephone number, zip code or address

9.) use a different password for each account

10.) don’t use user name

11.) deactivate accounts for terminated employees

12.) don’t allow shared accounts

13.) password contains upper, lowercase letters, non-letter
characters and numbers

Resources

Password Software - http://www.password-software.com

Passwords are not foolproof. Do not rely on a password alone to
protect sensitive information. Monitor accounts closely to
ensure that security is not breached.

About the Author -Sharon Housley manages marketing for
NotePage, Inc. http://www.notepage.net a company specializing
in alphanumeric paging, SMS and wireless messaging software
solutions. Other sites by Sharon can be found at http://
www.softwaremarketingresource.com , and http://www.small-
business-software.net

TECH TV STAFF GIVEN
THEIR 60 DAYS NOTICE

=======================================================

It looks as though TechTV may be nearing its final days. The
Laporte Report.. . Uh. . . reported this week that the TechTV
staff has been given 60 days notice and that the Channel as it
is now known will be gone by July. G4  the parent company
will move operations from San Francisco to L.A. Where it
will do something that probably won't be TechTV. Sad to see
them go, but the network hasn't really been very good for
the past year and a half or more. A channel that used to be an
authority in computers and technology has evolved into
MTV for adolescent computer nerds.
Just an opinion...

============================================================

1.5 MILLION DOWNLOADS PROVE
PC USERS HAVE LEARNED LESSON

============================================================

As the Sasser (not sure if it deserves a capital S) worm spread
across the Internet this week Windows users demonstrated
that they are learning how to combat viruses and
worms.Microsoft quickly placed a fix tool and patch on their
website when theyfound out about the new worm. 1.5 million
people downloaded the worm in
the first five days of the viruses known existence.

============================================================

WATCH OUT FOR SHOE HACKERS
OF THE FUTURE

============================================================

Smart phones are telephone/PDA combos - but what are smart
shoes?

A smart shoe, according to Adidas, is a shoe containing micro
processors, activity monitors, motors and pressure devices
that will work together to adjust the fit of the show according
to the wearers activities. The goal is the have a show that
reduces stress and other problems with the wearers joints by
making adjustments on the fly.

No word whether you will be able to get online updates for
the new shoes or whether Adidas will offer free tech support
for the new shoes. Rumor has it that Symantec may be
working on a new loafer and walking shoe edition of its
security software.
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Customize Your Computer
by Sandy Berger

Take a good look at your television. There are probably
thousands of other televisions that look and act just like
yours. Compare that to your computer and you will find that
your computer is uniquely your own. Once you have used
your computer for even a few days and have installed
programs, set preferences, and created data, your computer is
like no other in the world. It is as unique as a snowflake.
Yet there is still some hidden human need to personalize a
computer even more. I have never seen a television with
stickers, stuffed animals, or beads hanging from it. Yet, I
have seen computers filled with stickers, surrounded by teddy
bears, and covered with photos of family and friends. I have
even seen some painted bright colors and draped with alumni
flags. Perhaps a computer is more like a refrigerator where
you might see notes, magnets, and photographs. Certainly as
the kitchen has always been a family-gathering center, the
computer is now also becoming a center for every member of
the family. Other than painting your computer or draping it
with photos and other paraphernalia, there several other fun
ways to customize the computer.

Windows XP

If you are lucky enough to have Windows XP installed on
your computer, you can easily set up a different, customized
look for each user in your home.
Click on Start. Then choose Control Panel, then User Ac-
counts. While in this area you can set up an account for each
user, choose a password for them and even choose an icon to
represent that user. I highly recommend that you set up a user
account for any visiting friends or grandchildren that use
your computer, as well. This will allow them to have fun with
their own settings and will also   keep them from messing
with your programs, icons, and settings. You can also set up
users with older operating systems like Windows 98 or
Windows Me, but it is much easier and works much better
with Windows XP.

Color Your Desktop

If you are sick of Microsoft blue, you can change your
computer desktop to any color of the rainbow. You can also
fill it with a pattern, an image, or a favorite photo. Just right-
click on any blank part of the Windows desktop and choose
Properties. Then look through the Appearance and Desktop
tabs. You will find that you can use this area to customize
just about everything about your computer desktop.
You can use any picture as your desktop background, even
one you find on the Internet. Just right-click on any picture
and choose Set as (Desktop) Background.

Screen Savers & Themes

Screen Savers appear on your computer screen after a certain
period of inactivity. They are colorful, sometimes animated
graphics that are made just for fun. Right-click on any blank
part of the Windows desktop and choose Properties, just as
you did to color the desktop. This time however, you will
want to focus on the Screen Saver tab. Here you can set the
amount of time that will lapse before the screen saver turns
on. You can also choose from all the screen savers that are
installed on your computer. If you don't see anything you like,
go to any search engine like Google or Yahoo  and type in the
words Screen Saver. You will be presented with a list of Web
sites that offer every type of screen saver from tasteless to
truly artistic. Mac users needn't be left out. There are plenty
of sites for you. Some, like Mac Screen Savers are exclu-
sively for Mac users.
If you are using Windows XP, while you are looking at the
Screen Savers, you should also investigate the Themes tab. If
you are using an older version of Windows, you won't see a
theme tab, but various themes are available.   A theme is a
background plus a set of sounds, icons, screen savers, and
other elements that will set everything up with a single click.
Free themes can also be found on the Internet or purchased
from Microsoft in a package called the Microsoft Plus!.

Customize Icons

Change any icon on your computer by right-clicking on the
icon and choosing properties. Click on the Change Icon
button and choose any icon you like. Windows comes with a
set of standard icons, but you can find millions of others on
the Internet, if you desire.

Move the Taskbar

There are a lot of things that you can change in your Win-
dows settings. You can even move the Taskbar that normally
resides on the bottom of the screen to the top or sides of the
screen. Just place your cursor in any blank portion of the
Taskbar and drag it to any other edge of the screen. If it
doesn't move, you may need to unlock it first. Do this by
right-clicking on any blank area of the Taskbar, then click
Lock the Taskbar to clear the check mark.
There are many different ways to customize your computer.
Once you start, it can be difficult to stop. But go ahead and
have some fun. Start off with these simple customizations,
and before long you may be ready to create your own icons,
customize the sounds on your computer, and change your
mouse and pointer settings, as well. What ever you do - go
ahead - make it your own.

Sign up for Sandy's Newsletter at
http://www.compukiss.com/
Click on Newsletter at the top of the site in center.
She is also the host for AARP's Technology Section
which is excellent,
you can find it at: http://www.aarp.org/computers
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Software Review of:
Photo Album 4
By
Mike Runnels
From the October, 2003 issue of
PC Alamode Magazine

Got a digital camera? Do you collect digital images from the
Internet? Do your friends and family e-mail you pictures? Do
you know where they all are?

Jasc Paint Shop Photo Album 4 (Photo Album,
for short) is a software package that's really a

Swiss army knife of tools designed to help
you manage all those digital images. You can
create albums (hence, the product name),
digitally clean them up, and even distribute
them. Don't let the name fool you, though; it
may be called "Photo Album 4", but there

never was a "Photo Album 3". Jasc took some of t he image
manipulation tools from its award-winning Paint Shop Pro and
merged it with another of their packages called Media Center 3;
Photo Album has some of the good attributes of both pack-
ages, but it left some out, too.

System Requirements
Jasc give you some pretty low-end requirements for getting
the system up and running. For instance, it mentions a PC with
a Pentium processor, but it doesn't give a minimum speed, and
it says it needs 64 MB of RAM and 24 MB of free hard disk
space, along with a CD-ROM. It does mention, though, that it
can run on any version of Microsoft Windows from 98SE all
the way up to XP; hence, your true minimum system require-
ments are really based on the operating system you choose.
The user manual also states that you need a video card and
monitor capable of viewing 256 colors, but in my opinion,
that's only to install the software. To make the maximum use
of the application, go with a video card and monitor capable of
supporting 24-bit color or better; that way, you can manipulate
digital photographs as they would best be viewed and printed.

Given all the information in the previous paragraph, remember
that working with digital photography is memory and hard disk
intensive; maybe not as intensive as digital video, but inten-
sive nonetheless. Short answer: fast processor, fast hard drive,
more memory. Your digital photographs will thank you.

Hands-on
Installing Photo Album falls into the "piece of cake" category.
If you've got Autorun enabled for your CD-ROM, pop the disk

in and you're off. I tend to keep everything spread across
partitions and hard disks, so I didn't accept the defaults (which
are to put everything on the C: drive) and installed the applica-
tion to my graphics drive, but even that was easy. Like most
applications these days, this one put the usual entries in my
"All Programs" menu from the "Start" button (I'm using
Windows XP) as well as one on my desktop and even offered
to put one on my system tray.

I've used both Paint Shop Pro and Media Center for years, so I
thought I knew what I was in for when I fired the program up.
Well, you know what they say about assuming; Photo Album
was both more and less than I was expecting. First off, it
doesn't really create standalone albums like Media Center did,
i.e., thumbnails, but instead bases the album off the contents of
your directories on the hard drive. With Photo Album, if you
delete the thumbnail, you delete the image, too. Also, if you
create a new album from the contents of other directories, it
copies the image to the directory of the new album; this can be
pretty space intensive, especially if you tend to duplicate the
contents of other albums to make new ones.

Creating a basic album is real easy, though. Launching the
application defaults to a Windows Explorer-style tree struc-
ture; clicking on a folder immediately builds an album from
the digital image contents of that directory. See Figure 1.
Additionally, the album doesn't have to have digital photo-
graphs, but can be any file format it recognizes (GIF, TIFF,
PNG, PSD, QIF, SGI, TGA, JPG, BMP, FPX, and PSP) as
well as movies (MOV, AVI, DX, and FLC).

If you click on the Info tab on the left, you can get information
on the album or on images in the album. See Figure 2. You
can also add information about the album and/or images. For
instance, you can add an album or image title and description
that go beyond the benefit of a simple file name. There's also a
Keyword tab and a Search tab; the latter takes great advantage
of the Info and Keyword tabs, allowing you to make an image
search as broad or as narrow as you wish. But let's look at the
other side of the coin - the photo stuff.

Jasc put a lot of power in the tools for handling digital photo-
graphs. Double-clicking on an image opens it in its own
window and presents the tool bar at the top. You can expand
or contract the tabs on the left to give you more working
space, plus you can zoom in or out to vary your work space.
With the single image, you can do a lot of the same things you
can with Paint Shop Pro (or most image manipulation pro-
grams), like rotating and cropping the images, red-eye reduc-
tion, etc.

Some of the tools, though, are targeted at the novice, but are
powerful nonetheless. For example, the Quick Fix button.
Selecting an image and then clicking Quick Fix automatically
adjusts the contrast, brightness, and color balance. And
"quick" is right, too; it doesn't give options, it just makes the
adjustments.

Cont. on Next Page
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SENIOR CITIZENS

Senior citizens are constantly being criticized for every
conceivable deficiency of the modern world, real or imaginary.
We know we take responsibility for all we have done and do
not blame others.

HOWEVER, upon reflection, we would like to point out that it
was NOT the senior citizens who took:
The melody out of music,
The pride out of appearance,
The courtesy out of driving,
The romance out of love,
The commitment out of marriage,
The responsibility out of parenthood,
The togetherness out of the family,
The learning out of education,
The service out of patriotism,
The Golden Rule from rulers,
The nativity scene out of cities,
The civility out of behavior,
The refinement out of language,
The dedication out of employment,
The prudence out of spending,
The ambition out of achievement, or,
God out of government and school.
........And we certainly are NOT the ones who eliminated
patience and tolerance from personal relationships and
interactions with others!!
........And, we do understand the meaning of patriotism, and
remember those who have fought and died for our country.
Does anyone under the age of 50 know the lyrics to the Star
Spangled Banner?   or O Canada
Just look at the Seniors with tears in their eyes and pride in
their hearts as they stand at attention, on veterans day and our
great country's birthday .

YES, I'M A SENIOR CITIZEN!

I'm the life of the party...... even if it lasts until 8 p.m.
I'm very good at opening childproof caps...   with a hammer.
I'm usually interested in going home before
I get to where I am going.
I'm awake many hours before my body allows me to get up.

Cont. on P.19
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On the other hand, every time I used it, the end result was as
good or better than my attempts at making the same changes.
To top it off, if you find that every change made by Quick Fix to
images from the same camera look right, you can do batch
quick fixes. Just select the thumbnails you want to change
(using Ctrl-click for individual images or Shift-click for contigu-
ous images) from the Browse tab and then click on the Batch
button on the toolbar and select Quick Fix. Voila! They've all
been adjusted. If you want more control over the changes
made to your image, click on the Adjust button and select
either Adjust Wizard or Adjust.

There's even a Panorama tool. If you've ever really liked a
wide view of the countryside but couldn't capture it with a
single shot, this one's for you. Take several overlapping
pictures with your digital camera, import them into an album
(using the Camera button on the toolbar, natch), click on the
Panorama button, arrange them in the order they should
appear, and let the tool do the rest. The pictures are stitched
together and the total panoramic image is cropped horizontally
and vertically to remove any jagged edges and overlaps. You
then save it under a new file name and you're done.

The output options are impressive, too. Printing could take an
entire article by itself, but suffice it to say that you're not likely
to waste paper when printing one image or an entire album.
Contact sheets, wallet sizes, 5X7s, and combinations are all
possible, plus many more. You can take multiple images and
turn them into a Quick Time movie, or you can output one or
more albums to a video CD which you can share with others.

Where to get it
The price for Photo Album appears pretty consistent every-
where I looked in town. CompUSA and Best Buy are your
most likely candidates to have the product, and both offer it
for about $50. Surprisingly, you can get it directly from Jasc
for less than the retail cost; $42 will get you a full boxed
package, while downloading it will only cost you $38 (you'd
better have broadband, though). Jasc's web site can be found at
www.jasc.com. They're based in the States, so you can contact
them directly at:

Jasc Software, Inc., 7905 Fuller Road, Eden Prairie, MN
55344. Phone: (952) 934-8888.

Information about buying or registering the product has a toll-
free number you can call (800-622-2793), but tech support
issues are on a regular long-distance line (952-930-9171).
Everything has to be done, though, between 8am and 5pm
Central Time.

Conclusion
Would I recommend the product? Yep. If you're going to be
doing a lot of digital photography and have loads of images
spread out across several different media (hard disks, CDs,
floppies, etc.), and you don't need the horsepower of Paint

Shop Pro, this is for you. The quick tools and output options
are excellent and the album function is a definite plus. Have
fun with it!

Oh, and by the way; they even throw in two recordable CD-
ROMs to get you started on sharing your images.
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A Few Fundamentals
For Emailing Photos

By Don Edrington

One of the first rules of sending photos as email attachments is
to crop them whenever possible. The larger a photo is, the
longer it takes to upload and download, not to mention taking
up more disk space. Many snapshots feature one or two people
surrounded by acres of blue sky and green grass, or by walls
and furniture that do nothing to enhance the subject of the
photo.

The easiest program I’ve found for cropping is Irfanview (free
from http://www.irfanview.com). Use the left mouse button to
draw a rectangle around the important part of a photo and click
the toolbar scissors to CUT the selection. Then click the
toolbar PASTE icon to replace the original picture with the
cropped one. Finally, go to File > Save As and give the
cropped picture a new name with a JPG extension.

Why JPG rather than one of the other 18 file formats listed?
Well, JPG has become the accepted standard for compressing a
snapshot’s file size while maintaining its visual integrity.
Beyond that, one can choose different size/quality ratios when
saving JPGs — however, Irfanview’s default “80%” setting
works very well for most “family snapshots.”

As for the other format extensions (BMP, TIF, etc.) they are
best left to photo technicians.

Nonetheless, it’s helpful to know a little about the GIF format.
Although JPGs can contain millions of colors, GIFs are limited
to 256 and are often used for creating drawings seen on Web
sites. Furthermore, some GIFs can be animated and used as
attention-getters on Web pages and in emails. (However, GIFs
should not be confused with FLASH and other high-tech/high-
resolution animation files.)

Getting back to making pictures smaller, you may want to
reduce a large one to fit on a standard 8-1/2x11 page or into a
particular pre-defined space. Go to Image > Resize/Resample
and make your choices.

What About “ART” Files?

Although Irfanview works with most image formats, it does
not recognize files with an ART extension. ART is a
compression format peculiar to AOL and CompuServe, and is
their default for downloading images from the Web.

AOL and CS users can defeat this default by going to Settings
> Internet Options > AOL Browser, and choosing “Never
Compress Graphics,” whereupon their downloads will be in the
same format as everyone else’s.

Non-AOL/CS users who find themselves with an ART file can
double-click it so it opens in their default browser.

Then they can use File > Save As to change its format to BMP.
Finally, open the BMP with Irfanview (or any other image-
editor) and use File > Save As to make it into a JPG.

Emailing Multiple Photos

When you attach multiple photos to an email, they are
automatically compressed for faster uploading/downloading,
and then decompressed on the receiving end to appear in their
original form. However, different email clients have varying
file-size limitations, which may explain why a particular batch
of photos could not be transmitted. Spreading the photos over
additional emails can fix this.

Copying a Picture from the Internet

To copy an image from the Internet, right-click it and choose
Save Picture As, followed by giving it a name and choosing a
location. An easier way is to simply drag it onto your Desktop.
However, dragging doesn’t work with an image that is a
“hyperlink” (showing a pointing finger) — so use the right-
click method.

DONA’S COMPUTER CAPERS
By Dona Z. Meilach

MORE ON IDENTITY THEFT and WI-FI
SERVICE WITH YOUR FRIES AND
COFFEE

Two new words bursting into the computer lexicon are
“phishing” and “carding.” They target a serious new e-mail
scam being used by thieves and scammers to “fish” for users’
financial information and password data with sophisticated
lures.

In one common ploy, criminals pretend to be from legitimate
businesses. They tell recipients that they need to confirm or
validate their information to keep their accounts active, then
direct them to look-alike Web sites luring consumers into
submitting sensitive personal data. I’ve had them already from
my Visa account and the US Postal Service.

Scams like these are having a serious impact on growing
identity theft crimes. According to the Federal Trade
Commission, reports of stolen identities rose 88 percent last
year, growing from 86,000 in 2001 to 162,000 in 2003. “We
recommend that consumers not reply or click on the link in the
e-mail unless they are certain they are linking to a secure Web
site,” said Diana Don, Capital One’s financial education
director. “The FTC recommends you contact the company
requesting the data by phone to verify that the request came
from them and that they need this information.” Capital One
also suggests reviewing bank and credit card records on a
regular basis and reporting suspicious activity to the police.

Cont. on Next Page
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Of utmost importance is that consumers act quickly to save
themselves from fraudulent expenses charged on credit cards.
Prompt action can also save the government valuable time in
their efforts to curb online crime and catch “phishing”
criminals. (NUE)

————————————

COMPUTER CONVENIENCE CROPPING
UP EVERYWHERE

T-MOBILE SERVICE AT KINKO’S
Kinko’s, in partnership with T-Mobile, begins offering high-
speed wireless Internet access in more than 1,000 U.S. Kinko’s
locations. Subscribers to T-Mobile’s service can access the
Internet, send documents for production, connect with their
corporate networks or check e-mail — all wirelessly, from
anywhere inside a Kinko’s store.
It’s easy to connect with the T-Mobile service.
You will need three (3) items to get started.
1. A laptop or PDA with Wi-Fi 802.11b wireless
capability—Your device may already have this capability
built-in. If not, you can purchase a compatible card from any
major electronics retailer or Web store. If you have a PDA, you
can purchase a wireless card directly from your device
manufacturer.
2. A subscription to the T-Mobile service—Visit www.t-
mobile.com/ to sign-up for one of T-Mobile’s wide range of
subscription plans.
3. A Web browser—Use any standard Internet-ready browser
on any operating system. No additional software is required.
You can locate Kinko’s services offering T-Mobile service,
from www.kinkos.com and learn about T-Mobile at www.t-
mobile.com.

—————————

MCDONALD’S OFFERING HOTSPOT

 INTERNET SERVICE
rWherever you travel, it may be easier than ever to connect to
the Internet. McDonald’s announced that it will provide
HotSpot (wireless internet) service in its restaurants. It may not
pose a serious threat to Internet cafes, as one must still have a
laptop or PDA to use the wireless service. Chances are a large
percentage of McDonald Patrons don’t run around with their
equipment, or even have it. And those who do typically dash in
for a fast food snack and probably have Internet access at their
homes or offices.

McDonald’s is hoping to attract more Internet users and a
clientele that might otherwise be snacking elsewhere. The
problem may be that such users will occupy tables longer than
the usual table patron turn around. With more than 13,000
locations, the fast-food chain could provide a significant boost

to the Wi-Fi market while it aims to increase foot traffic into its
restaurants.

The success of the service will depend on the location and
charging the right amount for the service. McDonald’s and its
partners have tried a number of strategies for payments, such
as offering free service for a limited time with a meal purchase.
Pricing has differed in each of its locations. The company has
been bullish on urban areas and has said it won’t offer the
service in all its restaurants. Final pricing and locations are still
being determined.

Wi-Fi providers have targeted a growing number of potential
venues within which to establish access points, including
hotels, airports, phone booths, and restaurants. Coffee vendor
Starbucks and deli chain Schlotsky’s have already launched
commercial Wi-Fi services aimed at driving more foot traffic
into their stores and keeping customers there longer, and
they’ve reported some early signs of success. Barnes & Noble
is planning to install HotSpot networks in about 650
bookstores by September.

McDonald’s could be the largest potential partner for a
HotSpot operator in the United States because it has 13,000
locations and an All-American sort of audience,” said John
Yunker, a business analyst with Pyramid Research. The chain is
using an “at” sign (@) with an M in the middle as a logo to
help HotSpot subscribers identify locations that offer the
service.

=============

CUSTOMERS WHO HAVE WI-FI
CAN ADD MUSIC, TOO

Starbucks has the largest number of stores offering HotSpot
service in the United States, in partnership with T-Mobile USA.
The two companies have been working on the service since
2002. Starbucks wont reveal how many people have used the
service to date, or financial details. However, a company
representative said the service has helped keep users in its
stores longer, with the average session time lasting about 45
minutes.

“That more than likely leads to a second cup of coffee,” said
Anne Saunders, vice president of marketing at Starbucks.

Schlotzsky’s also found that by offering free HotSpot service
in select restaurants, it could encourage people to stay longer.
According to a survey conducted by Schlotzsky’s, 6 percent of
customers to restaurants with HotSpot service say the service
is the primary reason they come. Those are the kinds of
statistics that are raising interest at McDonald’s.



README.DOC Vol. 20.5 May 2004
ORANGE COAST IBM PC User Group

19

A side benefit for McDonald’s could be improved store
management, something Starbucks has experienced. Starbucks
district managers have used the HotSpot service to log into the
corporate network to order new supplies for each store and
update sales data. “One manager said that (HotSpot service)
was the single best thing they’ve been given to improve their
productivity “

Starbucks is also offering a music service. Working with
Hewlett-Packard, they will open a service so customers can
make personalized CDs while they sip. Starbuck’s first “Hear
Music” store opened in Santa Monica, California in March 04
with plans to install music kiosks in 2500 stores over the next
2 years. The system will allow users to choose from more than
250,000 online songs and to burn CD’s for $6.95 for five
songs with each additional tune costing $.1.00 more.

====================================
Dona Meilach is the author of over 85 books
with 10 on computers. Her just released newest
book is WOOD ART TODAY from Schiffer
Publishers. http://www.schifferbooks.com.
Put her name in the search box. Other computer
organizations interested in running this column
should contact the author. The column is also
available as a free E-zine. Subscribe DCC:
Contact Dmeilach@msn.com.
Dona’s Computer Capers may also be found at
http://www.smalladdictions.com/Skateboard.

====================================

Senior Cont. from P.16

I'm smiling all the time because I can't
hear a thing you're saying.
I'm very good at telling stories;
over and over and over and over...I'm aware that other people's
grandchildren are not nearly as cute as mine.
I'm so cared for ---
long term care, eye care, private care, dental care.

I'm not really grouchy,
I just don't like traffic, waiting, crowds, lawyers, loud music,
unruly kids, Jenny Craig and Toyota commercials,  barking
dogs, politicians and a few other things I can't seem to remem-
ber right now. I'm sure everything I can't find is in a safe secure
place,  somewhere.
I'm wrinkled, saggy, lumpy, and that's just my left leg.
I'm having trouble remembering simple words like.......
I'm beginning to realize that aging is not for wimps.
I'm sure they are making adults much younger these days, and
when did they let kids become policemen?

Gateway Closes Stores

By
Sandy Berger

Although many in the industry expected the computer-maker’s
move, most consumers were shocked by Gateway’s
announcement that it will close its 188 retail stores. Gateway
plans to lay off 2,500 employees, over one-third of its current
workforce. The closings were announced on April 1st and the
stores were to be completely shuttered by April 9th. The speed
of the closings left many consumers in the process of
purchasing computers, repairing computers and/or taking
classes in a lurch.

If your Gateway product is currently in process through a
Gateway store, there is recourse. Go to the Gateway Web site
and click on the “Find A Store” link at the top of the home
page. You will see a section with the header “Find out how the
Gateway Store closure announcement affects you” with two
links below it. If you click on the
“Consumer” link it will take you to a Frequently Asked
Questions section with all of the appropriate contact
information for various situations. Those who
purchased in-store training are instructed to contact the
Learning Customer
Service team at 1-888-852-4821. Telephone numbers and
contact information for other situations are also listed.
Industry experts expect Gateway to now forge alliances with
retail stores. Gateway’s recent purchase of eMachines may lead
the way for Gateways to be sold in Best Buy’s retail outlets
since eMachine’s and Best Buy already have an excellent
working relationship. CompUSA and Circuit City are also
mentioned as possible Gateway retail outlets. Gateway’s
Shawna Ploen states, “We hope to sell Gateway products
through other retailers and we’re currently in the midst of those
discussions, but at this point nothing has been finalized.”

I'm wondering, if you're only as old as you feel, how could I be
alive at 150?
And, how can my kids be older than I feel sometimes?
I'm a walking storeroom of facts.....  I've just lost the key to
the storeroom door.
Yes, I'm a SENIOR CITIZEN and I think I am having the time of
my life!

Now if I could only remember who sent this to me, I wouldn't
send it back to them,  but I would send it to many more!
Now- Have I already sent this to you???????
If so, I'll try not to do it again (for a while.)
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The DealsGuy
For June, 2004,
by Bob (The Cheapskate) Click
Greater Orlando Computer Users Group

Because of all the great feedback, I’ll start this month off with
more about interesting trade shows we have worked, but I’d
like to change the topic next month to technology for homes.
March began with one of my favorite shows called MegaCon,
otherwise known as the “Comic Book” show. I first worked it
last year and was warned I would be seeing all those crazies
and weirdoes. Well, I WAS certainly surprised, but I didn’t
interpret the attendees that way at all. I saw many people who
loved their hobby and had even hand crafted their costumes to
represent certain characters, such as comic book, game, space
and other characters. Many costumes were absolutely
gorgeous. I saw bodies and faces that required much time for
makeup to get the necessary effect, and yes, some looked
weird (like they are supposed to). I enjoyed the folks with the
space suits and those looked pretty awkward to wear. One
young woman was a bit too daring with her costume, but she
was quickly noticed, escorted from the show and informed that
paint does not substitute for wearing an upper garment in
public, especially when there are children present. Never mind
that the men loved it. We stopped another woman with
extremely skimpy lower attire and referred her to show
management.

Looking for a badge or wristband on people entering with
costumes was not easy, but some held them out or pointed to
them for us. The show occupied 108,000 sq. ft. of exhibit
space with about a quarter of it devoted to special artistry
tables, celebrity autograph tables, game tables and the food
area. The rest was vendor booths. There were lots of things
other than comic books, including robots and digital badges.
This show also used several large meeting rooms off the lobby
area that worked with such things as games and animation
movies in 3D. They well exceeded the 20,000 expected
attendees and the show floor was very packed. There were
eight famous celebrities, such as June Lockhart and Angela
Cartwright (of Lost In Space fame) signing autographs. We
met most of them since they went through our entrance, and
they were great people. My grandson took home my show
guide so I can’t list them all.

I talked to many attendees asking how they acquired their
beautiful costumes and most said they had hand crafted it
themselves with help from family members. I talked to many
people with professional jobs and good incomes that loved this
hobby. Even though I had a very intensive job, I was
entertained all day long just by watching the people. I saw
more daring cleavage during this show than any other I have
worked. Remember, a badge or wristband (some won’t wear a
wristband on the wrist) might actually be looped anywhere so
they are difficult to spot. Of all the shows I have worked, this
show’s attendees were by far the nicest to work with. We were
never angrily challenged for trying to enforce the rules and

everybody simply asked what they had to do. Mostly,
acquiring a proper badge or wristband was the answer. Even
though this show was mostly young people, there were some
older generation and a few seniors. Since there were three
other trade shows in the building at the same time, some tried
to use other badges.

We also worked the Home Electronics Expo [ http://
www.ehx2004.com ] and [ http://www.virtualEHXspring.com
] in March and I was impressed with all the amazing
technology that can improve your lifestyle (at a price). Most of
it was about automated/remote lighting (low voltage), video
and sound. All this can be controlled from anywhere in the
house that you desire, and even remotely if you prefer. You
can dial home (phone or computer) and check your refrigerator
(if you’re stopping at the store), start the food preparation,
have your favorite music going and set the house temperature
as well as take a look at the children or pets through a camera.
There were lots of wall mounted thin screen TVs in the show,
but the largest I saw on display was only a 60" plasma screen
(they come as large as 80"). Many vendors specialized in
cabling, or switching, only. Others specialized in audio or
video specialty installations and a few distributors such as
Worthington had booths. There were a multitude of audio
speaker designs, including some wall mounted ones that
blended in with the decor, but had great sound.

There were also electrically operated driveway gates, garage
doors, and even windows that would close automatically, such
as by a rain sensor, or by remote control. A couple of booths
offered timed or remote controlled drapery rods and vertical
blinds. My favorite booth was the one with weather stations. [
http://www.peetbros.com ] I was devastated when my own
weather station went out a year ago, but it was a 20-year-old
Heathkit and that company was gone years ago. I need a new
one. I liked the design of these because of the illuminated
readings rather than LCD, and it so happens their offices are
within driving distance for me to check on a deal.

Unfortunately I missed working the Microsoft Show being
held at the Gaylord Palms Resort, but we prefer not to work for
the company that was given the security job, although they had
asked us. Now here is what I have:

*Reminder On A Great Software Deals

Colleen Toumayan from Executive Software called to remind
us all that their special offer for Diskeeper Professional Edition
8.0 bundled with Undelete Home Edition for just $49.95 is still
good. Check at [http://consumer.execsoft.com/home.asp ] to
order this bargain. We all know what great products Executive
Software produces.

*We All Like Freebies

Sally Springette, Editor for The Rochester Computer Society
Monitor [ http://www.rcsi.org ], sent me this URL that I found
interesting and felt you might like it also. If you don’t like
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rebates, then skip this and keep going. This URL [http://
www.freeafterrebate.info/index.php?topic=Hardware ] offers
leads to purchasing products that will be free after the rebates.
Be aware that third-party vendors offer these products and you
should do your own homework diligently before you decide to
order. It might even be an older or discontinued product and
you will probably pay a shipping charge. With that caveat in
mind, check it out and I imagine that it will change quite often.

*Help For Your E-mail

I have a couple of friends who use MailWasher and say it
works pretty well to eliminate spam, although it stopped a few
legitimate e-mails at times. I questioned Hewie Poplock, a
good friend whose opinion I value, who has used MailWasher
for a two years and he is completely sold. He says if you set it
up right, it won’t filter out good messages, but if you get too
fussy, it could happen. Sounds logical, but I have not had
enough experience as yet. It incorporates learning by Bayesian
statistics and uses FirstAlert!, a real-time global spam
database. Something else I like is that you can check your e-
mail right on the server instead of on your own computer, if
you prefer.

Mathew Miller, Product Development Manager for
MailWasher, made a special offer available for user group
people and I asked him to extend the deadline so I could
include it in my June column. He agreed so you get the price
advantage. Mathew is offering us MailWasher Pro and a one-
year subscription to FirstAlert for just $29.95, a saving of
$7.00. You will need the promotional code of QTUGAD to
order. This offer is good until July 31, 2004. Get more info on
this tool for all that disgusting spam and download at [http://
www.firetrust.com/products/pro/ ].

That’s it for this month. Meet me here again next month if
your editor permits. This column is written to make user group
members aware of special offers or freebies I have found or
arranged, and my comments should not be interpreted to
encourage, or discourage, the purchase of any products, no
matter how enthused I might sound. Bob (The Cheapskate)
Click [ bobclick@mindspring.com ]. Visit my Web site at
[http://www.dealsguy.com ] for interesting articles from user
group newsletters. I also posted some interesting NEW Web
site pages for your viewing. Explanation on the Web page.

Minutes for the March 2004
OCIPUG Board of Directors Meeting,
March 27, 2004
The March Executive Board of Directors (Board or BOD)
Meeting of the Orange Coast IBM PC User Group (OCIPUG)
was held on March 27, 2004, at the Costa Mesa Senior Center.
President Michael Moore called the meeting to order at
12:10pm, with five of the eight officers and directors, and SIG
Coordinator Robert Strader present.
♦ Note that there are presently only eight members of the
OCIPUG Board of Directors, as Past President Leonard Stein is
also serving as Treasurer/CFO.  The meeting quorum require-
ment remains at five.
As Secretary Frank Mastroly was absent from the February 
2004 Board of Directors Meeting, there was no motion to
approve the minutes of the February 2004 Board of Directors
Meeting.

President’s Report: — President Michael Moore stated that his
President’s Report was published in the March 2004
Readme.Doc.  A summary of the items follows.

During the past several weeks, after a lot of hard work by our
Webmaster, Mark Borison, OCIPUG has a new and greatly
improved website (www.ocipug.org).  A few of the improve-
ments include:
1) All of the SIG Groups have their own webpage where
announcements, and other relevant tips, tutorials, and informa-
tion that relates to that particular expertise will be posted.
2) Our website now has a search function, where you can not
only search for information on our web site, but you can also
search the internet from our website.  Also you can click on the
site map if you are having trouble finding a page on the site.
3) Webmaster Mark Borison has also compiled some of the best
computer tutorials that I have ever seen (including Free Web
Based Training) on all of the Microsoft Office Products.

Because of the new OCIPUG Website, we have recently
received an e-mail from Jorge Schulz, who was (and technically
still is) OCIPUG's member # 007.  In his e-mail, Jorge stated
that he is the Technical Support Manager of the Latin Division
of Brother International and that he was pleased to see that
OCIPUG was still alive and to keep him informed about any
anniversary plans.  In passing, Jorge was the member who came
up with the name README.DOC for our newsletter.

This month marks the 19th Anniversary of OCIPUG, and it is
probably an appropriate time to start  thinking about next year’s
20th Anniversary.  If you have any suggestions/ideas on how
we should mark this momentous event, please feel free to let
either myself or any of the other members of Board of Direc-
tors, know your ideas, because after all, OCIPUG is your Club.

In March the General Meeting program includes a presentation
on Intel's New Hyperthreading technology, presented by Vice
President, Dave Wintle, and we will also have a presentation on
the Smart Computing (www.smartcomputing.com) web site.
Cont. on P. 24

http://safari.oreilly.com/
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RAM Size vs Hard Drive Size
By
Don Edrington
The Senior Computer Tutor
http://www.pcdon.com

Rarely does a week pass that I don't get an email from
someone saying an error message tells him he has "insuffi-
cient memory," whereupon he tells me he has free hard disk
space of, say, 20 GB. Shouldn't that be plenty of spare
memory? Well, the message refers available RAM (random
access memory) rather than the amount of free storage space
on his C-drive.

Most Windows-based computers will run on 128 MG of
RAM, but really should have 256 MG to work at peak
efficiency. The additional 128 MG can be purchased and
user-installed -- but I prefer having it installed by a technician
at an established computer store or service center. The
additional RAM is not all that expensive -- and will make
most PCs run faster and more efficiently.

To see how much RAM you have, click on Start > Help &
Support and type "RAM" into the Search box.

To check your free hard disk space, double-click My Com-
puter and then right-click the C-drive icon. Click Properties to
see the ratio of used/free disk space. The mammoth sizes of
today's hard drives give many of us all the storage space we
will ever need, unless we tend to fill it up with tons of graphic
and/or media files.

Good Time to Do Routine Maintenance

While in Properties, you can click on Tools and perform
important hard drive maintenance for pre-WinXP computers,
by choosing ScanDisk and Defrag; or by choosing Defrag and
Check Disk on XP machines. If these programs get hung up
in any way, additional "run" options can be found at
www.pcdon.com/page82.html.

Automatic File Saving

Another frequent question is "Can I recover a file that
crashed, but which I had not saved?" Well, unless an auto-
matic backup option had been established within the program,
the answer is normally no. MSWord users can find these
choices by going to Tools > Options > Save.

Many folks will type a lengthy email message, but lose it if
the email program suddenly crashes. Outlook Express users
can protect against this by doing a periodic Ctrl+S (Save)
which will place a copy of the current message in their Drafts
folder. This copy will be automatically deleted after the
completed message is sent.

AOL/CompuServe users can go to File > Save As and keep a
newly-typed message as an HTML or as a plain text file, by
giving the message a name and location. However, I can find
no way outgoing Juno messages can be saved while being
typed.

Incremental File Saving

In any case, the best way to save any new email message is to
create it off-line in your favorite word processor, followed by
saving it and copying and pasting it into your email client's
outgoing message box.

Even this method, however, is not fool-proof if the backup
copy is deleted or over-written. Those who are serious about
backing up any kind of lengthy document will give its copies
periodic incremental names, such as Message-1, Message-2,
etc. By the time the document is completed as, say Message-
10, the preceding nine versions will still be in place as extra
insurance.

---------------------------------

(Editor's note: Don Edrington lives in Costa Mesa
Ca where he writes a bi-weekly newspaper column
called PC Chat. He also teaches computer applica-
tions part-time at local schools and does freelance
tutoring. His clients are almost exclusively seniors
who are new to computers and who appreciate
being taught by someone of their own generation.
The thing he loves most, however, is maintaining
and updating his website, www.pcdon.com, which is
dedicated to giving seniors more information about
computing, along with telling some funny anecdotes
about things that happened while coming of age in
post-WWII Hollywood. You may send your ques-
tions to Don at Don@pcdon.com.)
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SeniorNet Costa Mesa

IBM Contributes 7 Computers To
The Costa Mesa SeniorNet  Learning Center

By Mark Borison
Editor README.DOC

As the Costa Mesa SeniorNet Learning Center quietly cel-
ebrated it's 5th  year in existence this month, IBM generously
contributed seven completely new, state of the art computer
systems. The grants were obtained through a program it
conducts whereby retired members of their corporation who
have volunteered and become involved with Non-Profit
organizations, may obtain grants to further their organization's
work. Since the Learning Center at the Costa Mesa Senior
Center was fortunate to have three former IBM employees,
Norm Beres, Margie Lord, and Nickie Sierp, a proposal was
developed and approved,  whereby The Costa Mesa SeniorNet
was able to receive the new equipment to replace our outdated
Pentium 1 & 2's with the following:

DESCRIPTION
      ===========
MACHINE TYPE     8433 (THINKCENTRE A50P SERIES)
MODEL 98U
PROCESSOR INTEL PENTIUM 4/2.8 GHZ
MEMORY 256MB
DISKETTE STORAGE 1.44
HARD DISK 40GB
CD-RW YES (48X)
MODEM NO
AUDIO YES
ETHERNET YES
DISPLAY 65176LN 17"
(MULITIMEDIA)

FORM
MICROTOWER (BLACK)
KEYBOARD ENHANCED
MOUSE YES
EXPANSION BAYS 4
EXPANSION SLOTS 2
PRELOADED SOFTWARE WINDOWS XP

PROFESSIONAL

 All we need to do now is upgrade the ram from 256 to 512 and
before long the SeniorNet members will be Knowbies not
Newbies! As soon as this session ends (next week) the new
computers will be set up for the Summer Session which starts
the week of June 21st.

In other SeniorNet news, David Wintle (OCIPUG VP) and
Mark Borison (Newsletter Editor, etc etc) were honored at the
recent Costa Mesa Volunteer Appreciation Dinner by being
inducted into the CMSC Volunteer Hall of Fame!

Fun In the Sun and Computers, Too!
Patricia Hill and Judy Taylour
Co-chairs, SW User Group Conference

Web Site Contest! Door Prize Drawings! Networking! T-shirts
and Welcome Kits! All this and more can be found at the 11th
Annual Southwest User Group (SWUG) Conference.
This year's activities run from Friday evening, August 6
through Sunday, August 8 at the Mission Valley Hilton in San
Diego. Planned activities include workshops, vendor-spon-
sored presentations and meals, a Saturday evening Vendor
Faire, numerous prize drawings as well personal contact with
participating vendors. "The leadership of the conference
always finds good vendors who make excellent presentations
about their software. In many cases these vendors will give
each attendee a copy of their software to take home and learn,"
said Ed Zarr, Sunland Village East Computer Club.

There will be newsletter and web page contests for all user
groups with officers in attendance. All attendees will receive a
t-shirt and Welcome Kit stuffed with all sorts of promotional
materials, most with special pricing. User group members will
have an opportunity to interface and network with user group
leaders to share ideas and experiences, as well as solutions to
problems. This year's user group leader and PC skill enhance-
ment workshops will be even more exciting.

The conference registration fee is $40 per person if paid by
July 16. If registered and paid between July 17 and 23, the fee
is $50; July 24 through the conference date is $60. The
conference registration fee includes admittance to all work-
shops and Vendor Faire; meals and vendor presentations; a
Welcome Kit and a T-shirt. "I especially enjoyed the Vendor
Faire on Saturday night when I had an opportunity to see close
up and hands on the many products, applications,and equip-
ment that the company representatives brought along for
display and sale,"Delvina Fiducia, SIG leader, Temecula
Valley Computer User Group said.

The conference will be held at the Mission Valley Hilton, 901
Camino del Rio South in San Diego. Reserve your room at a
special group rate of $109, single or double occupancy. To
make your reservations, call the toll-free reservation number
800-733-2332 by July 16 and tell them you are attending the
Southwest User Group Conference. Stay at the host hotel and
you are automatically entered into a drawing to receive one of
your conference nights FREE!

For more information contact
Judy Taylour at judy@swugconf.org,
Patricia Hill at swugconf@aol.com,
or visit www.swugconf.org.
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This is a presentation that we had postponed in January, due to
the fascinating presentation by the Digital Photoguy.
While the Attendance at the Tuesday Night SIG Groups is
slowly improving, we are still missing one important person.
YOU!  I've said this before and I'll say it again that the SIG
Groups are an excellent way to get more specialized assistance
with your computer and related equipment.  Most of our SIGs
have members there that have probably experienced the same
questions/problems.  IN fact, you may even learn a trick or two
about your computer that you may not have thought of.
Once again, remember that the OCIPUG website (http://
www.ocipug.org/), the SIGs, the Newsletter, and the General
Meetings are here for you, and I hope that you will consider
them as a resource for use on a regular basis to help take some
of the mystery out of your personal computer.  I hope to see you
not only at the upcoming General Meeting, but at one or many
of the upcoming SIG Meetings.
Secretary’s Report: — No report.
Treasurer’s Report: — Treasurer Leonard Stein reported that
during March he had deposited $372 from the raffles and the
auction of Office 2003.  In addition, he wrote a check to Red
Davidson to cover OCIPUG’s donation to SeniorNet for
purchase of a PCI video card for the instructor’s computer.
Finally, during the March General meeting we received six
membership renewals.  In a motion by Director Ed Leckliter,
seconded by Vice President Dave Wintle, and carried, the March
2004 Treasurer’s report was accepted as presented.
Committee Reports:
Program Committee Report: — No report as Program
Committee Chairman Member Mark Borison was absent (see
also President’s report)
SIG Reports:

SIG Coordinator Robert Strader reported that the
April 2004 SIG schedule is as follows:
♦ Internet and Web Page Design (Michael Moore and Mark
Borison), 1st Tuesday of each month.  On April 6, Mark will
discuss web sites containing sources of information for web site
development.
♦ Hardware (Ed Leckliter), 2nd Tuesday of each month.  On
April 13, Ed will present the fourth in a five-part series on
building your own PC covering the installation of the hard drive
and other drives.  Ed is soliciting ideas on future hardware
topics, as the present series will terminate in May.
♦ Windows 9x/XP (Robert Strader), 3rd Tuesday of each
month.  On April 20, Robert will continue to cover Windows
tips and tricks.  If you have any questions or problems, send
them to Robert via e?mail for discussion at the SIG.
♦ Digital Photography and Scanning (David Wintle), 4th
Tuesday of each month.  On April 27 David will continue his
presentations of the book “Complete Digital Photography – see
the March Readme.Doc for a review of the book.
There was a brief discussion relative to the life projector bulb,
with the concern being that the one we use may no longer be
available when the present one burns out, which may not occur
for two or three years.  On the other hand, we may be able to
purchase a new one then for the same money that we could buy

a new bulb today.  This item remains unresolved.

SeniorNet Report: — Secretary Frank Mastroly reported that
the next SeniorNet team meeting will be on Friday, April 16,
2004, at 3:00 pm.  The current session of classes began on
Monday, March 12, 2004 and, as usual, the SeniorNet team is
in need of additional coaches, with the only requirement being
to be able to follow what the instructor is saying and to be one
step ahead of the students.  It was also noted that the new
OCIPUG web site has links to the SeniorNet operation.

Webmaster Report: — No report, as Webmaster Mark
Borison was absent.  However, as noted in the President’s
report, the new OCIPUG website is operational.  Mark would
appreciate e?mails with suggestions for additions and/or
corrections.  One suggestion made was to have individual
OCIPUG email addresses for each office, e.g.,
president.bod@ocipug.org, with any e?mail sent to that address
automatically forwarded to the officer’s or director’s home
e?mail address.  This should not be a problem as we have 100
available from our web hoisting service.

Membership Committee Report: — No report.  It was noted
that OCIPUG is in need of a Membership Committee Chair-
man.

Advertisings and Public Relations Report: — No report.

Sunshine Committee Report: — This committee, under the
direction of Director Sandi Tierney, is responsible for sending
congratulations for achievements and condolences for family
losses.  For instance, she recently sent condolences and flowers
upon the death of long time OCIPUG member Kenneth Paeth.

Old Business: — President Michael Moore has mailed a letter
to Aviva Goelman, the Costa Mesa Senior Center Executive
Director, formally requesting permission to use the Senior
Center as the OCIPUG mailing address.  Secretary Frank
Mastroly reported that the UPS Store we currently use requires
a payment of $69 plus late charges for the first three months of
2004 before they will release the mail that has accumulated
since December.  Frank was authorized to take care of this.

New Business: — As SIG Coordinator Robert Strader will be
out of town from April 29 through June 6, he is looking for
volunteers to set up the projector and seats for the SIGs and
general meetings.  It was noted that the Senior Center staff sets
up the tables and seats for the SIGs and then breaks the room
down afterwards.

Adjournment: — Moved by Director Ed Leckliter, seconded
by Treasurer Leonard Stein, and carried.  The meeting was
adjourned at 12:50 pm.  The next OCIPUG Board meeting will
be on Saturday, April 23, 2004, immediately following the
April General Meeting.
Respectfully submitted,
Frank Mastroly, Secretary
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Membership status: [ ] New [ ] Renewal - Member #________ Membership type: [ ] Individual [ ] Family
Title: Mr. Mrs. Ms. Dr. Prof. Hon. ( ) (Circle one)
First Name: ___________________________ Last Name:______________________________
Street Address: _____________________________ City:________________ State: ___ Zip:________
Home Phone:( )________________ Work Phone: ( )______________ Fax: ( ) ____________
E-mail address: ________________________________________________________
Profession/Trade: ______________________ [ ] Retired [ ] Current Occupation: _______________

Family Member(s) Names: _____________________________________ Company: _______________
Annual Dues:
Make check payable to OCIPUG                                                                                    Individual $30.00 $ _______
and mail to the above address                                                                                       Family $35.00 $ _______
or bring to the General Meeting.                                                                                    *Full-time student $20.00 $ _______
                                                                                                                                           Donation $ _______
I consider my skill level to be:
[ ] Beginner [ ] Novice [ ] Intermediate [ ] Advanced
                                                                                                                                           Total Amount Paid $ _______
                                                                                                                                           *(U-grad 12 units; grad 6 units)
I learned about OCIPUG from: _______________________
                                                                                                                                            Today’s Date : __________________

Orange Coast IBM PC User Group
695 West 19th Street

Costa Mesa, CA 92627

Material for the June 2004 issue must be received
on or before June 15th, 2004

mborison@yahoo.com


